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Build Your Room.

The Build Your Room section is the first step in room design. You may select from a
variety of inital layouts, after which, you can customise the room shape to anything as
complex as you like. With the aid of the grid tool if required. Once your room shape is
complete, you may choose from a variety of doors and windows to place in your room.
All work is done in a 2-dimentional environment, but selection 3D will provide you with a
rotating viewpoint of your inital work.

For more detailed help, select one of the following:
Creating a room shape
Selecting and Positioning Windows and Doors
Deleting Windows and Doors




Creating a basic room shape in Build Your Room.

Select Layouts from the tab book. All room shapes are displayed and edited in plan
view. Scroll the database display to see the predifined shapes available. Click to
select a shape or start with the default rectangle provided.

Click on a black wall to select it. Drag selected walls around to create your own room
shape. Drag by the red sections to move the entire wall. Drag by the yellow sections to
break the wall. Click 3D View to see your room in three dimensions and 2D View to
return to plan view.

Please note walls with windows and doors positioned on them cannot be broken without
deleting the windows or doors first. Ideally create a shape you are happy with before
selecting and positioning windows and doors.

See also:
Selecting and Positioning Windows and Doors
Deleting Windows and Doors




Selecting and Positioning Windows and Doors in Build Your Room.

Select either the Windows or Doors category from the tab book. Scroll the database
display to see the different windows or doors available. Click on an item to select it.
Move your cursor to the wall you wish to position your window or door on and click the
wall to drop it. You can now drag the window along the length of the wall to position it
more accurately. Click 3D View to see your room in three dimensions and 2D View to
return to plan view.

See also:
Creating a room shape
Deleting Windows and Doors




Deleting Windows and Doors in Build Your Room.

In 2D View drag windows and doors over the silver bin, when the bin turns red release
your mouse button to delete.

See also:
Creating a room shape
Selecting and Positioning Windows and Doors
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Decorate

Decorate Your Room.

The second section provides you with functionality to start painting walls to different
colours of your choice. You may also apply any variety of the textures available as wall
paper or brick work to give a realistic feel.

Later on in your design, you may return to Decorate Your Room in order to change
textures and fabrics which reside on different furniture objects that you have imported.

All textures are scalable using the Scale texture button. Also, if you feel ambitiuous,
the Import texture button allows you import your own textures, maybe from your own
home, or possibly a picture of your family to apply to a picture.

For more detailed help, select one of the following:
Using Paint
Using Fabrics
Using Surfaces

Import a Texture
Scale a texture




Using Paint in Decorate Your Room.

Select paint from the tab book. In the database window you will see all the colours
available. Click on a colour to select it. Left clicking an item will fill with the colour range
defined by the yellow rectangle. Right clicking an item will fill with the individual colour
defined by the blue rectangle.

Paint can be used to colour some furniture items as well as floors ceilings and walls.

See also Using Fabrics
Using SurfacesUsing Wallpapers




Using Wallpapers in Decorate Your Room.

Select wallpaper from the tab book. Click on the different categories to display the
different types available in the database window. Scroll the database display to explore
the different categories. Click on a wallpaper to select it, and then click on an item to
cover it.

Wallpaper can be used to texture some furniture items as well as floors, ceilings and
walls.

See also Using Paint
Using Fabrics

Using Surfaces
Import a Texture
Scale a texture




Using Fabrics in Decorate Your Room.

Select Fabrics from the tab book. Click on the different categories to display the different
types available in the database window. Scroll the database display to explore the
different categories. Click on a fabric to select it, and then click on an item to cover it.

Fabrics can be used to texture some furniture items as well as floors, ceilings and walls.

See also Using Paint
Using SurfacesUsing Wallpapers

Import a Texture
Scale a texture




Using Surfaces in Decorate Your Room.

Select Surfaces from the tab book. Click on the different categories to display the
different types available in the database window. Scroll the database display to explore
the different categories. Click on a texture to select it, and then click on an item to cover
it.

Different surfaces can be used to texture some furniture items as well as floors, ceilings
and walls.

See also Using Paint
Using Fabrics
Using Wallpapers

Import a Texture
Scale a texture
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Furnish

Furnish Your Room.

The third section is where the real fun starts! In here, you may bring in a large variety
of house-hold furniture, appliances and other objects in many different styles and
cultures. Don’'t worry yet about where the are going to go, just pull in what type of
furniture you are interested in and drop them into a space within your room.

Some objects belong on the floor only, others are designed to hang from the ceiling
whilst some only make sense up against a wall. If you bring in these objects, Interior
Designer 2 will handle the more detailed placement for you. More fine adjustment to
position can be done in the next section - Arrange Your Room.

For more detailed help on Furnish Your Room, select one of the following:
Importing Furniture in Furnish Your Room

For more detailed help on Arrange Your Room, select one of the following:
Move Furniture
Expand Furniture
Shrink Furniture
Rotate Furniture
Delete Furniture




Importing Furniture in Furnish Your Room

Select a room type from the tab book. Click on the different categories to display the
different types of furniture available in the database window. Scroll the database
display to explore the different categories. Click on an item to select it. If your room is in
3D View it will switch to 2D View , move your cursor to the position you wish to place
your item and click to drop it.

Click 3D Viewand move around your room to see items in three dimensions.

See also Move Furniture
Expand Furniture
Shrink Furniture
Rotate Furniture
Delete Furniture
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Arrange Your Room

The third section, Furnish Your Room allowed you to bring in a whole host of objects.
Now you have to sort them all out. There are many ways to move and rotate objects
into their correct position, but they are all done in this section - Arrange Your Room.

Objects may be positioned in a number of ways. The first place your would want to go
would probably be into 2D View. From here, you may pick up and move objects from

one side of the room to another. You may also rotate objects providing there is space

to do so.

Once you have got your objects into roughly the correct position, enter 3D View.
Objects may be selected simply by clicking on them. Once an object is selected, you
may move it either using the four types movement control on the tab book at the top of
the screen or directly using the dragging with the left and right mouse buttons. Left
mouse gives you direct movement control whilst right mouse gives you rotation.

If you wish to expand or shrink any of the objects, you may do so by selecting the third
and fourth tabs on the tab book and using the arrows.

For more detailed information on Arrange Your Room select one of the following:
Move Furniture
Expand Furniture
Shrink Furniture
Rotate Furniture
Delete Furniture




Moving Furniture in Arrange Your Room.

Click on an item to select it. Once selected it will flash red. Furniture can be dragged
into position in both 2D View and 3D View Alternatively, select move from the tab book
and click on the arrows to move the selected item up, down, left, right, forwards and
backwards.

Furniture can be moved in both 2D View and 3D View.

See also Expand Furniture
Shrink Furniture

Rotate Furniture
Delete Furniture




Expanding Furniture in Arrange Your Room.

Click on an item to select it. Once selected it will flash red. Select Expand from the tab
book and click on the arrows to expand the selected item up, down, left, right, forwards
and backwards.

Furniture can be expanded in both 2D View and 3D View.

See also Move Furniture
Shrink Furniture
Rotate Furniture
Delete Furniture



Shrinking Furniture in Arrange Your Room

Click on an item to select it. Once selected it will flash red. Select Shrink from the tab
book and click on the arrows to shrink the selected item inwards from the top, bottom,
front, back and sides.

Furniture can be shrunk in both 2D View and 3D View.

See also Move Furniture
Expand Furniture
Rotate Furniture
Delete Furniture




Rotating Furniture in Arrange Your Room.

Click on an item to select it. Once selected it will flash red. Click an item with the right
mouse button, and holding the right mouse button down drag to rotate the item
clockwise and anticlockwise. Alternatively, select rotate from the tab book and click on
the arrows to rotate the selected item clockwise and anti-clockwise.

Furniture can be rotated in both 2D View and 3D View.

See also Move Furniture
Expand Furniture
Shrink Furniture
Delete Furniture




Deleting Furniture in Arrange Your Room.

Click on an item to select it. Once selected it will flash red. Press the delete key on
your keyboard to delete the selected item. Alternatively, click 2D Viewto see your room
in plan view. Drag furniture items you wish to delete over the silver bin. When the bin
turns red release the mouse button to delete.

See also Move Furniture
Expand Furniture
Shrink Furniture
Rotate Furniture




View

View Your Room.

Viewing your room is where you can show it off to your friends and family. There are a
number of functions available for you in View Your Room. They are as follows:

Recording a Fly Through Sequence
Loading and Saving a recording

Adjusting Lighting
Save an Image of Your Room

Estimating Flooring, Paint and Wallpaper costs




Recording a Fly Through Sequence in View Your Room

Use the following controls to record and play back yourself moving around your room:
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Start Recording.

Stop recording and playback.

Rewind to the beginning of your recording.
Playback your recording.

Pause recording or playback.

Fastforward to the end of your recording.
Step forward through your recording.

Step back through your recording.



Loading and Saving a Recording

Save Button

Click the save button to activate the Save Recording dialogue box. Enter a filename
and choose a location to save your recording to. Please note that you are saving a
‘camera movement’ only, and you must also save your room separately using save in
the file menu.

Load Button

Click the Load button to activate the Load Recording dialogue box. Select or enter the
filename and location of the recording you wish to load. Note that you are loading a
‘camera movement’ only, and you must also load your room separately using open in
the file menu.

If you wish, you may use a recording from one world in another. This is best for external
fly-bys which you have made in the past. Recording of interiors are a little more tricky
but if you keep to the ceiling side, you can often make generic recording that can be
used in all your rooms.

Reset Button

Click this button to remove your current recording from memory. This removes any
frame counts which may be on screen when in View Your Room.



Adjusting the lighting in View Your Room

You may only effect the lighting of your world from full screen mode in View Your
Room. To go to full screen press the full screen button.

You may effect the lighting in two ways. The first is to use the White Light controller
which consists of a slider taking your ambient light from zero (complete darkness)
through to 100% ambient light. Click on the lighting button in full screen mode to bring
up this control.

If you wish to adjust the amount of Red, Green and Blue lighting independantly of each
other, select the RGB button from the White Light controller. This provides you with 3
separate sliders which allow you to adjust the intensity of the three colours allowing you
to produce a warm or cold feel to your room.



Moving around your room.

Using the Navigation Bar:

*

Click and hold to move yourself upwards. (!! Move North in 2D)
+

Click and hold to move yourself downwards. (!! Move S in 2D)
&

Click and hold to move yourself to the left. (I! Move W in 2D)
L4

Click and hold to move yourself to the right. (!! Move E in 2D)

Holding the mouse down move towards the top of the arrow to move forwards, and towards the bottom to
move backwards. (!! Zoom in and out in 2D)

<

Click and hold to look down towards the floor. (!! Not available in 2D)
Y
‘ Click and hold to look up towards the ceiling. (!! Not available in 2D)
‘ Click and hold to turn yourself to the left. (! Not available in 2D)
Click and hold to turn yourself to the right. (I! Not available in 2D)

Other controls on the navigation bar include:

Click this button to toggle the navigation bar on and off.

Click this button to maximise your view to fill the whole screen.

See Also: The spacebar (Proportional Mouse Control)



Using the Space Bar (Proportional Mouse Control)

Although tricky at first, once you get to grips with using this type of navigation, you will
find it a lot more flexible that the traditional navigation bar movement method. It has
two advantages:

« You don’t require the navigation bar to be on screen hence it is possible to navigate
when in full screen mode and when the navigation bar is hidden.

- It allows you to move and rotate at the same time, rotate and look up and down at the
same time and all at different levels of speed.

To Use:

Place you mouse pointer in the middle of the Interior Designer 2.0 window, and press
the space bar on your keyboard. A small box will appear where your mouse pointer was
located. This represents your anchor point around which you can navigate using the
mouse.

Move the mouse pointer to the left of the box to turn left, and to the right of the box to
turn right. Move the mouse pointer above the box to move forward and below to move
backwards. Holding the right mouse button down, move to the left, right, above and
below the box to move left, right, up and down respectively. Holding the left mouse
button down move above the box to look up and below the box to look down.

See Also: The navigation bar
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Setting up view points

Click views one to six to see your room from different viewpoints. Right click a viewpoint
to activate the Viewpoint Set-up dialogue box. Move around your room until you have a
view you are happy with and click ‘store’ to save it. Click the ‘human of height’ radio
button to set-up views of different heights. Click close to exit Viewpoint Set-up.



Further Help

There are three types of help in Interior Designer 2. These are:

Windows Help

This is what you are reading now. You can get detailed help on any function by
navigating through the Windows Help system via Hypertext links or the Search function.

Context Sensitive Help (Rollover help)

If context sensitive help is selected in the Help menu (by default it is selected), then the
Statusbar at the bottom of the screen shows single line help about buttons on the
screen.

Handyman Help

The handyman sits on the top right of the screen and is there to give you advice on
creating a room. If you click on the handyman and then a piece of furniture, he will do
his best at giving some useful advice relating to that object.
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Click on the Handy Man to obtain a top tip on items within your room. Having clicked
the Handy Man the mouse pointer will change to a question mark and you can then
activate top tips on specific items by clicking on them.

Top Tips from the Handy Man

Top Tips can also be activated by selecting Top Tips from the Help Menu.



Context Sensitive Help (Rollover help)

The status bar is the bar at the bottom of the Interior Designer 2 window.

This is used to display instructions and messages which are activated by the position of
the mouse pointer when Context Sensitive Help is active.

It also displays any warnings or explainations about why you cannot perform any
particular action.

Context Sensitive help can be disabled by unselecting it from the Help Menu.



Interior Designer 2 Tools

Click a tool to jump to that topic:

2D View

3D View

Axis Toggle
Show Grid
Snap to Grid
Import a Texture
Scale a Texture
Import external furniture
Calculate Costs
Save View
Adjust Lighting
Adjust Volume

Using Hold and Fetch
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Scrolling the Database window

Fullscreen mode

©

Leveling your view
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Click this button to view your room in plan view. This will allow you to manipulate walls in Build your Room, and make the
movement of walls and furniture across rooms a quick and trival task.
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Click this button to view your room in three dimensions. Most functionallity in creating your room can be performed from this
viewpoint.



Gt

Click this button to view the XY (2D) or XYZ (3D) axis. Track your orientation in two or three dimensions, as you move navigate
around your room.



Left click this button to toggle the grid on and off. Right click this button to adjust the grid settings.
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Click to toggle movement snapping on and off. When the grid is active, walls and furniture will jump to the grid lines and
intersections when you move them. This aids wall and furniture alignment. Right click this button to adjust the grid settings.



Select this to use the full screen resolution of your display when in modes higher than 640x480 and to get lighting functionality when
in View Your Room.

Click to toggle to full screen mode.



Use it to bring up the White Light dialogue box to adjust the abient lighting on the world. The Red, Green and Blue channels may
be adjusted independantly by selecting RGB from the White Light dialogue.

This button is available when in Full screen mode in View Your Room.



Click this button to activate the Import Texture dialogue box. Click on an <Empty> box to select a file from disk. Once a texture
has been imported, you can select it by clicking on the palette picture and pressing OK.

Up to 5 images can be currently selectable at once but you can import as many pictures as you wish by loading a new file over a
previously allocated box.



Click this button to activate the Scale Texture dialogue box. Provides the functionality to change the size of wallpaper, carpet etc...
in the room.



Import external furniture

Click this button to activate the Import Furniture dialogue box. Select the external VCA file and click OK, then place the furniture
object as usual.






2D 3D

2D/3D Modes

Some operations at better in a plan view and others better in 3 dimensions although
Interior Designer 2 allows you to perform most operations in either.

Toggling between 2D and 3D can be performed in any of the five sections, although 2D
in Build Your Room gives you a moving viewpoint of your room allowing you to see the
basic wall structure of the room you have created so far.
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Axis button

This button helps you to orientate your self, particularly in the 3 dimentional
environment.
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Left click this button to toggle the grid on and off.

Grid button

The grid provides an easy way of getting the scale of walls correct in Build Your Room.
When the grid is active, the Snap To Grid button becomes available.

Right clicking on this button brings up the Grid Settings dialogue box. From here you
can change your the current units (metric or imperial measure) and change the size of
the grid itself.

See also Snap to Grid Button.
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This functionality is only available when the grid is switched on.

Snap to Grid button

Left click to toggle on and off. When snap is active, walls and furniture will jump to the
grid lines and intersections when you move them. This aids wall and furniture alignment.

Right clicking on this button brings up the Grid Settings dialogue box. From here you
can change your the current units (metric or imperial measure) and change the size of
the grid itself.

See also Grid Button.



Importing an external texture

Click this button to activate the Import Texture dialogue box.

Click in a picture frame to activate the Import a Picture dialogue box. Locate the file
you wish to import and click open. In the Import Texture dialogue box click the picture
you have imported and click OK to close the dialogue box. Now you can click the area
you wish to cover. Your picture will be stored in the Import Texture dialogue box and
can be re-selected here.

See also Scale a Texture.
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Click this button to activate the Texture Scaling dialogue box.

Scaling a Texture

Click on the texture you wish to scale. Click the arrows to scale the texture horizontally
and vertically. To maintain the proportions of the texture make sure you have ‘auto
scale’ selected, before using the scaling arrows. You can return your texture to its
original state by clicking the ‘reset texture’ button. Click OK to accept your changes, or
cancel to forget them.

See also Import a Texture.
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Click this button to import furniture external to Interior Designer 2’s default supplied
library.

Importing external furniture

Interior Designer 2 has been specifically designed to allow third party developers to
create extra furniture for you to use at a later date.

These extra models will become available through Europress and developers through
the Internet or by the release of extra CD-ROM libraries.

You may also import existing Interior Designer 2 furniture through this function which
provides you the extra flexibility of importing Doors and Windows directly into your room
and choosing not to have objects which normally stick to walls, to be placed freely.

To do this load up any of the VCA files from within the Database directory on your CD-
ROM or Hard Disk. The following groups exist:

Database\Clipart directory contains all clipart found in Furnish Your Room.
Database\DoorWin directory contains all clipart found in Build Your Room.

Database\Environment directory contains any bits of clipart found in the View Your
Room.

After selecting a file and clicking OK, the furniture placement works exactly as if you had
selected it from the database window.

See also Import external Textures.




Calculating Costs.

Click this button to activate the Costs dialogue box. You will be given the surface areas
of the walls, floor and ceiling of your room and a break down of the types of materials
used. Enter your own unit costs for wallpaper, paint or flooring and have overall costs
calculated for you. Pressing the Update button will recalculate any new values you
may have entered. Press OK when finished. Values entered will be stored for later.



Using Save View.

Click this button to save the current view of your room to disk.



Adjusting Lighting.

This option is only available in full screen mode in View your Room.

Click this button to activate the adjust lighting slider. Drag the slider to see your room in
varying shades of light and dark.



Adjusting Volume.

Click this button to activate the adjust volume slider. Drag the slider up to increase
volume and down to decrease volume.

This option is only available in View your Room.
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When you have your room at a stage you are happy with click the Hold button to store
your room in the computer’s memory. You can then experiment further with different
arrangements or colour schemes. Click the Fetch button to restore your room to its’
previously held state.

Using Hold and Fetch
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Use the right and left arrows to move the database display forwards and backwards.
Click on the item or texture of your choice and click in your room to place it.

Scroll Database window



iy

Click this button to toggle to full screen mode.

Fullscreen button

Select this to use the full screen resolution of your display.

If you are in View Your Room mode, you may adjust the lighting within the world using
the lighting button.

You may still navigate when in full screen using The spacebar (Proportional Mouse
Control).

To return to normal screen mode, press to Restore Screen button on the bototm right on
the screen.
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Click this button to level your viewpoint in 3D View and to centre your room in 2D View.

Home button



Getting Around Your Room

The navigation bar at the base of the screen provides you with a number of basic
movement arrows in which to navigate the room. Putting these aside, there are a
number of tools available to help you move around your room in the easiest way
possible:

There are six view point buttons at the bottom right of the screen on the navigation bar.
Left clicking on these will place you at a predefined point within your room. You may
change your viewpoint type and location by right clicking on one of the viewpoints.

The Full Screen mode mode allows you to see your room at a much higher rendered
state. None of the normal buttons are displayed when in this mode but you may still
navigate using the The spacebar (Proportional Mouse Control). You can also setup
your own lighting conditions.

If you loose your orientation in 3D, you can click on the Home Button to place your
viewpoint level again. Clicking on this in 2D centres the room and sizes it to take up
the full screen.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Save

Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Save Screen Saves a screen shot of your room to disk

Print Screen  Prints the current screen

Preferences  Allows certain setup parameters

Exit Exits 3D Interior Designer 2.0




Help menu commands
The Help menu offers the following commands, which provides assistance with this application:

Contents Calls up the Windows Help system for 3D Interior Designer 2.

Context Enables/Disables rollover help on the status bar

Sensitive

Help

Top Tips Activates the Handy Man allowing you to click on items in you room
for Top Tips

Licence Displays the Licence Agreement of this application.

About Displays the copyright and version number of this application.




New command (File menu)

Use this command to start a new room from scratch. Selecting the new command will clear out any
existing room that is loaded, prompting you to save your work before commecing.



Open command (File menu)

Use this command to open an existing document. Selecting the open command will bring up the Open
VRT file dialog box  to allow you to specify which file you want to open.

You can create new rooms with the New command.

Shortcuts
Keys: CTRL+O



Open VRT file dialog box

The following options allow you to specify which file to open:

File Name

Type or select the filename you want to open. This box lists files with the extension you select in the
Files of Type box.

Files of Type
Select the type of file you want to open.

Look in
Select the directory in which 3D Interior Designer 2 stores the file that you want to open.



Save command (File menu)

Use this command to save the active document to its current name and directory. When you save a
document for the first time, 3D Interior Designer 2.0 displays the Save VRT file dialog box so you can
name your document. If you want to change the name and directory of an existing document before you
save it, choose the Save As command.

Shortcuts
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document. 3D Interior Designer 2.0 displays the Save
VRT file dialog box so you can hame your document.

To save a document with its existing name and directory, use the Save command.



Save VRT file dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name. A filename can contain up to eight
characters and an extension or file type of up to three characters.

Save In
Select the directory in which you want to store the document.

Save As Type
3D Interior Designer 2.0 adds the extension you specify in the Save As Type box to your filename.



Preferences command (File menu)

Use this command to edit the preferences of 3D Interior Designer 2.0 displays the Preferences dialog box
S0 you can name your document.



Preferences dialog box
The following options allow you to adjust default settings within 3D Interior Designer 2.0
Devices Tab

Device Setup
Select device you wish to activate and click on Enable. Also, check the Save Settings box in order
to make setting perminant.

Mode Select
Select how you wish to activate the Proportional Mouse Control. By default, both the space bar and
the middle mouse button will activate this movement.

Mouse Home
Select whether the centre box should be visible and if it should default to the centre of the screen or
not.

Movement sensitivity
Specify how sensitive you wish to have the mouse set at for Navigation. This is handy if you wish to
take a tour of a particular environment space.

Speed of movement
Drag the slider to choose a setting between slow and fast to dictate how fast you move when
navigating around your room.

Display Tab

Viewpoint Movement:
State how fast you move and rotate in each frame refresh

Viewpoint Lock:
Inhibit rotation in X Y and Z directions

Drawing Options:
Adjust the render quality of the screen in order to improve in screen refresh rates
and adjust the zoom perspective.



Exit command (File menu)

Use this command to end your 3D Interior Designer 2.0 session. 3D Interior Designer 2.0 prompts you to
save or discard rooms with unsaved changes.

Shortcuts
Keys: CTRL+ X



Contents command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to
step-by-step instructions for using 3D Interior Designer 2.0 and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 3D Interior
Designer 2.0.



Licence command (Help menu)

Use this command to display the Licence Agreement of your copy of 3D Interior Designer 2.0.



Context Sensitive Help command (Help menu)

Use the Context Sensitive Help command to obtain help on areas of 3D Interior Designer 2.0 window.
Context Sensitive Help can be toggled on and off within the help menu. When you have Context Sensitive
Help active, the mouse pointer will activate help on the status bar when rolled over buttons and areas
within the 3D Interior Designer 2.0 window.



Top Tips command (Help menu)

Use the Top Tips command to obtain a tip on specific areas of and items within your room. When you
have Top Tips active, the mouse pointer will change to a question mark and you can then activate tips on
specific items by clicking on them. Top Tips can also be activated by clicking on the Handy Man.



Printscreen command (File menu)

This command allows you to take a print of the current viewpoint. When selected, choose which printer
you wish to send to and any other of the standard printer settings before clicking OK.






